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From The Chief Editor's Desk
Halloween was a HUGE affair at our house, as I suppose it would be in anyone's house where a three and six year old reside. The hospital where I work hosted a "Trunk And Treat" for the kids in the employee parking lot. Lots of candy to be had there. Then, the Kansas City Zoo hosted a "Boo At The Zoo" Halloween celebration. Lots more candy to be had there, too. And then, the kids went Trick-or-Treating around the neighborhood on Halloween. All totalled, the kids ended up with way, way more candy than is healthy. Without a doubt, I'll be taking some of those "unhealthy" treats into work to share with my co-workers in a few weeks, who will likely devour them in less than a day. There's no need to "ask" the kids. The candy will simply just disappear.
There's one thing I really dislike about the end of the year. First, we have Halloween, with all that candy. Then, less than a month later, we have Thanksgiving, with all of its heavy, carbohydrate saturated dishes. And then, less than another month later, we have Christmas, with yet another "feast" and all kinds of holiday candy and baked goods. It's no wonder that with so much gluttony in the last quarter of the year that so many people make New Year's resolutions to lose weight. It must be all that weight they put on in the final three months of the previous year. But then again, it's in our nature to fatten up for the winter, in order to help insure our survival during leaner times.
My daughter seems to think (remember, she's only three years old) that candy ... num-nums to her ... and other "sweets" are THE main staple of the food pyramid. She may proclaim that she is "full" from dinner, but that "fullness" only lasts until something sweet -- like desserts or candy -- is offered.
Boo At The Zoo, with Bumblebee (Ryan) and Princess Anna (Lexi).
We try, as much as we can, to teach the kids how to eat a healthy diet, and to make good choices. My son isn't obsessed with sweets. He's perfectly happy eating meat and other high protein choices (cheesy scrambled eggs and tacos are two of his favorite foods). But my daughter is all about the carbs, and the sweeter the better ... in her eyes, anyways. We try to steer her towards healthier choices, like fresh fruits over candy and pastries. Oranges, apples, bananas, and strawberries are some of her favorites. But sometimes, you have to give in. Every child craves those delectable sweet treats. Come to think of it, I'm not a child and even I crave those sinfully sweet treats every now and again.
About this month's cover ...
November 18th represents the 91st "birthday" of Mickey and Minnie Mouse. On that day in 1928, the first Mickey Mouse short cartoon, Steamboat Willie, was released. To pay homage to their birthday, this month's cover features two Tux penguins dressed as Mickey and Minnie Mouse re-enacting a scene from that first short cartoon. Over the years, Mickey and Minnie Mouse have become instantly recognizable among people the world over.
Until next month, I bid you peace, happiness, serenity and prosperity.
GIMP Tutorial: Reflective Water Effect
by Meemaw
This is a tutorial for adding a water effect to a photo. I saw two of them on YouTube - there are actually many GIMP tutorials on YouTube, if you just search for GIMP.
I grabbed a photo of the Grand Teton mountain range from WikiMedia Commons. Most of these are free-to-use images - however, you should check on each photo to see if you need to credit the photographer/artist. This one was taken by Michael Gäbler.
I also found a photo of some water we'll use. There is a little bit of water in the photo, but I want to make more.
The first thing you want to do is duplicate your layer (because we'll need two). Then, you want to add an alpha channel to your top layer by right-clicking the layer and choosing "Add alpha channel". An alpha channel adds transparency to the layer, so if you delete part of that layer, as we're about to do, the layer underneath shows through. If there was no alpha channel, and you deleted part of that layer, you would see whatever background color you have at that moment (mine would have been white).
For now, turn off the visibility of your bottom layer. Then, with your top layer selected, choose your Lasso Tool and outline the area in your top layer photo that you want to change to water. I made mine just the slightest bit wavy at the top, since lake shores don't usually run in a straight line.
The next thing you want to do is use your Bucket Fill tool and fill this area with a grey. If it only fills a few little bits of the selection, go to your tool settings and choose "Fill whole selection".
I want to make a small border between the fill and the photo, so go to Select > Shrink, and shrink your selection about 7 pixels (although you can use whatever looks good to you.)
Now, press the delete key. You'll see everything within the selection is gone and that part of your photo is transparent.
Now my aim in leaving the small grey border was to have a slight change between the vegetation and the water, so the only border I need is the top one right next to the plants. Choose Select > None to deselect the area, then use your Eraser Tool to erase the sides and bottom lines.
Now we're going to start the reflection. Turn on the visibility of your bottom layer, choose it, and select Layer > Transform > Flip Vertically. Choosing the Move Tool, move your layer up until the reflected part at the bottom matches up pretty well. You can see the border between them at the grey line.
Now we want to give the reflection a wavy effect, so choose Filters > Distorts > Ripple. In this newer version of GIMP, I hadn't used Ripple yet, but it's not hard. Make sure that Preview is checked, and you can also check Split View, which shows a before and after view of your screen, so you can compare.
When you see a reflection in the water, it is nearly always wavy, except for those times that the water is absolutely still, and then your reflection may still be distorted. In the filter, Ripple, I used the following settings: Amplitude - 6, Period - 240, and left everything else at default. However, you can experiment to see what you think looks best.
Now that we have our reflection looking more natural, we'll add some actual water to the picture. I saved a picture of water from another photo and will use that.
Add a new white layer between the two layers you have, and open the water picture. Copy and paste it onto the new layer. You may also have to scale it to make sure it will fill the area you have over the reflected layer before anchoring it as well. Right now it will completely cover the reflection you just worked on. With that layer still chosen, go to the layer attributes at the top of the layer list and set the opacity down to about 20, but you may want to experiment there as well. Now you can see the reflection through the water.
Before you finish, you may want to crop your project (I see some transparency at the bottom of mine). Also, our grey line is still in the middle of the picture. We want to smudge that just a bit to just make a slight shadow between the scenery and the reflection. You might have to zoom in to do that. Every time I'm zoomed in, working on something, I want to look past the edge of my project, and sometimes GIMP won't let me. However, see that plus sign in the bottom right corner of your canvas? Grab and hold that and move your mouse. GIMP will move your photo however far you want to move it, giving you a view of the edge (and past it) that you want.
When you finish your image, and are satisfied with it, save and export it. I did two... one with the border between the picture and reflection, and one without. Do yours whichever way you like best.
Short Topix: Kernel Lockdown Feature Coming To Linux
by Paul Arnote (parnote)
Password Psychology Analyzed
You've heard it all before. Don't reuse passwords from site to site. Use a unique password for each site you visit. However, it seems unlikely, despite ALL of the security breaches that we constantly hear about in the news, that this unsecure habit is about to change anytime soon. Day after day, pilfered user credentials go up for sale on the "Dark Web."
LastPass (makers of the popular web browser password manager) and Lab42 partnered up to survey adults around the world to see if they could figure out why, after all the information out there about the risks of password reuse, users continue the risky behavior. The nuts and bolts of the survey was released as an infographic on the LastPass blog. The meat of the survey results is in an executive report (PDF) from LastPass and Lab42.
If you're the least bit concerned about online security, both the infographic and the executive report are good and fairly interesting reads. Here at The PCLinuxOS Magazine, we've covered password security several times, including strategies for how to create unique, secure passwords.
Remember that your online credentials are a form of currency, especially among the less-than-scrupulous hackers and users of the "Dark Web." Using a secure and unique password for each site you visit that you must log onto means that ONLY that particular password for that particular website is compromised in the event of a data breach. All of your other passwords for other websites remain secure, protecting your private online data.
Why Chrome Gobbles So Much RAM & How To Tame Its Appetite
If you read my articles frequently, you know that I really don't care much for the Google Chrome web browser. Yes, I know it's the most popular web browser in the world at this time, but I abhor its voracious appetite for RAM and CPU cycles. Unless you have an abundance of RAM and a very fast CPU, using it can be slow and cumbersome.
Well, the reason Chrome consumes so much RAM and so many CPU cycles is because each tab -- and in some instances certain page elements -- are loaded into separate processes, each consuming those precious computer resources. It stands to reason that the more tabs you have open at any given time, the more RAM and CPU cycles Chrome is going to consume. The reason for this is so that if one tab or page element crashes, the other tabs or page elements are (hopefully) not affected. Then, Google Chrome pre-renders the pages, in an effort to enhance your web experience. THEN, you can add in poorly written browser extensions and web pages that might, over time, leak memory. The next thing you know, all of your available RAM is consumed, and your CPU is chugging along at 80%+ usage. We won't even talk about how Chrome phones home to Google with ALL of your browser activity.
Fortunately, you can quickly figure out the culprit of who's being the major memory and CPU cycle hog. Press Shift + Esc to display Chrome's internal task manager. Look to see which tabs and/or extensions are consuming the most memory. If it's a tab, you will know which one(s) to close. If it's an extension, you will know which one you will need to uninstall. Despite its features, it might not be worth the memory and CPU cycle drain.
According to an article on Lifehacker, there are also some extensions that will help lighten the memory and CPU load for Chrome. The Great Suspender will suspend tabs after a certain amount of time of inactivity. The tabs will remain open, but will take a little extra time to display when you switch to them if they have been put into a suspended state. OneTab takes a different approach. When you have a bunch of tabs opened up, hit the OneTab button. All the tabs will be closed, and a single tab will open in their place, with the URL of each of the previously opened tabs listed. You then click on the link to open select sites in a new tab, saving a tremendous amount of memory and CPU cycles. Session Buddy is another extension that allows you to categorize and save groups of tabs to make it easier to access them later.
Kernel Lockdown Feature Coming To Linux
Coming to the Linux Kernel 5.4 branch, the Linux Security Module (LSM) will prevent "high level" access -- in some cases, even root -- from tampering with kernel functionality, according to an article on ZDnet. The feature will (at least initially) be turned off by default, because of the possibility that it might "break" existing systems.
Here's an excerpt from the description on the git.kernel.org website:
This patchset introduces an optional kernel lockdown feature, intended to strengthen the boundary between UID 0 and the kernel. When enabled, various pieces of kernel functionality are restricted. Applications that rely on low-level access to either hardware or the kernel may cease working as a result - therefore this should not be enabled without appropriate evaluation beforehand.
The LSM should strengthen security by widening the division between userland and the kernel. The new module should restrict certain kernel functionality, even for the root user. This should make it harder for compromised root accounts to wreak havoc on the rest of the operating system.
The LSM module has two lockdown modes. "If set to integrity, kernel features that allow userland to modify the running kernel are disabled," said Torvalds. "If set to confidentiality, kernel features that allow userland to extract confidential information from the kernel are also disabled."
The new lockdown feature got its start in the early 2010s, and was spearheaded by Matthew Garrett, now a Google engineer. The main objections to it came from Linus Torvalds, as evidenced in this 2013 article on ArsTechnica (warning: adult language at link). As a result, some Linux vendors (such as RedHat) created their own security module separate from the kernel, that ran on top of the kernel. A middle ground was reached between the parties in 2018, and work has progressed from there.
The move has been lauded by the Linux community and cybersecurity experts alike.
Firefox Extension Hides Detection Of Private Browsing Mode
Most browsers today sport a private browsing mode, including Firefox. Users have demanded it, since little to no information from a private browsing session is saved as a permanent record. It helps insure privacy, and that users aren't tracked as easily from site to site to site. Some users use private browsing mode almost exclusively.
A few months back, Google Chrome developers attempted to close a loophole that allowed paywall sites and other sites to detect when a user was using private mode browsing. While initially successful, sites wishing to not allow users to use private browsing modes found other workarounds, effectively nullifying the work of the developers.
Users utilize private browsing mode for a number of reasons, the least of which is to help insure their privacy. Right or wrong, users also use -- or attempt to use -- private
browsing mode to circumvent paywall sites that limit the number of articles a user can read without paying for a subscription. The content providers (typically newspaper and magazine sites) want to limit unfettered access without being paid. Users wanting to circumvent the paywalls liken it to finding a copy of a newspaper in a park refuse bin. They didn't pay for it, but they can still read the content. Plus, no one wants to pay for a subscription to a site that they only occasionally or sporadically read/visit.
I first found out about the Firefox Hide Private Mode extension from an article on gHacks. From that gHacks article:
The Firefox extension Hide Private Mode disables the workaround (that uses the IndexedDB API). All it takes is to install the browser extension in the Firefox web browser and allow it to run in private windows. Just open about:addons in Firefox, click on the Hide Private Mode extension, and switch the "Run in Private Windows" option from don't allow to allow.
Firefox also uses a similar IndexedDB API, just like Chrome. This extension blocks detection of the use of IndexedDB API to signify that the user is using private browsing mode, rendering one of the wor5karound detection strategies useless.
What's even better is that the extension is open source, and you can report issues, as well as download/view/contribute to the code, at its GitHub page.
HUGE sudo Bug Found!
PCLinuxOS is rather unique among Linux distros in that it does not routinely use sudo to temporarily grant administrative access/rights to ordinary users. For Linux users distro hopping, the lack of the use of sudo is mystifying and puzzling. Virtually every other Linux distro supports the use of sudo. The tool (that is what sudo is, it's a tool) is available for installation from the PCLinuxOS repository, but it typically is not installed by default.
Old-Polack wrote a forum post explaining why PCLinuxOS shuns the use of sudo. We even ran that post in The PCLinuxOS Magazine as an article in the May, 2012 issue. When used as intended, sudo is usually a fairly safe tool. But, when used improperly, sudo can be a nightmare for system security.
So, when a new security bug was found in sudo (CVE-2019-14287), most PCLinuxOS users were not affected. Present in versions of sudo prior to 1.8.28 (which is also the latest version available in the PCLinuxOS version), setting sudo to execute as user -1 or 4294967295 treated the user as user 0, or the root user.
According to an article on The Hacker News:
Since the attack works in a specific use case scenario of the sudoers configuration file, it should not affect a large number of users. However, if you use Linux, you are still highly recommended to update sudo package to the latest version as soon as it is available. ?
So, if you've installed sudo in PCLinuxOS previously, be sure to run updates on your system to resolve the security issue.
GNOME files defense against patent troll
Orinda, CA -- 2019/10/21
News from Gnome.org
A month ago, GNOME was hit by a patent troll for developing the Shotwell image management application. It's the first time a free software project has been targeted in this way, but we worry it won't be the last. Rothschild Patent Imaging, LLC offered to let us settle for a high five figure amount, for which they would drop the case and give us a licence to carry on developing Shotwell. This would have been simple to do so; it would have caused less work, cost less money, and provided the Foundation a lot less stress. But it also would be wrong. Agreeing to this would leave this patent live, and allow this to be used as a weapon against countless others. We will stand firm against this baseless attack, not just for GNOME and Shotwell, but for all free and open source software projects.
For these reasons, GNOME Foundation Executive Director Neil McGovern instructed our legal counsel at Shearman & Sterling to file three papers with the court in California.
First: a motion to dismiss the case outright. We don't believe that this is a valid patent, or that software can or should be able to be patented in this way. We want to make sure that this patent isn't used against anyone else, ever.
Second: our answer to the claim. We don't believe that there is a case GNOME needs to answer to. We want to show that the use of Shotwell, and free software in general, isn't affected by this patent.
Third: our counterclaim. We want to make sure that this isn't just dropped when Rothschild realizes we're going to fight this.
We want to send a message to all software patent trolls out there — we will fight your suit, we will win, and we will have your patent invalidated. To do this, we need your help. Please help support the GNOME Foundation in sending a message that patent trolls should never target free software by making a donation to the GNOME Patent Troll Defense Fund. If you can't, please help spread the word with your friends on social media.
PCLinuxOS Recipe Corner: Spinach, Ricotta and Sausage Calzones
Spinach, Ricotta and Sausage Calzones
Ingredients:
1 box (9 oz) frozen chopped spinach
1/2 lb ground Italian sausage, browned and drained
1 cup whole milk ricotta cheese
1 cup shredded mozzarella cheese (4 oz)
1/4 cup grated Parmesan cheese
1 teaspoon Italian seasoning
16 oz refrigerated pizza dough
1 egg, slightly beaten
Pizza sauce or marinara sauce, if desired
Directions:
1. Heat oven to 375F. Spray cookie sheet with cooking spray.
2. Cook spinach as directed on box; allow to sit a few minutes until cool enough to handle. Squeeze cooked spinach between paper towels to remove excess moisture. Place spinach in large bowl. Add sausage, ricotta, mozzarella, 3 tablespoons of the Parmesan and the Italian seasoning to bowl; stir until well combined.
3. Divide pizza dough into 8 balls. Roll and press each ball into a circle 5 to 6 inches in diameter. Place meat mixture onto one half of each of the balls, leaving a 1/2 inch border around the edge. Fold dough over filling; pinch and roll edges to seal in filling.
4. Transfer to cookie sheet. Brush tops of calzones with egg. Prick tops of calzones with fork to allow steam to escape.
5. Bake 20 to 22 minutes or until dough is golden brown, topping with remaining 1 tablespoon Parmesan cheese during last 3 minutes of baking. Cool 10 minutes on cookie sheet. Serve warm with pizza sauce.
6. Freezer Directions: Make as directed through step 3. Place on cookie sheet, and freeze about 4 hours or until firm. Place frozen calzones in resealable plastic freezer bag, and freeze. When ready to cook, place calzones on cookie sheet, and brush with egg. Bake 25 to 30 minutes or until dough is golden brown, topping with remaining 1 tablespoon Parmesan during last 3 minutes of baking. Serve with pizza sauce.
Expert Tips:
Use ground beef or ground chicken in place of the Italian sausage.
ms_meme's Nook: Going Up To Linux
Internet Archive Releases 2,500 More MS-DOS Games
by Paul Arnote (parnote)
Most of us here can remember the bunches and bunches of high quality MS-DOS games that were around in the late 80s and into the 90s. I know we all had our favorites. One of the very first games I got inextricably "hooked" on was Wolfenstein 3D, from id Software. I can't even begin to calculate how many hours I sat in front of that computer screen, much to the dismay of my then wife, playing that game.
Thus began my pseudo love affair with the games from id Software. I graduated from all things Wolfenstein to all things Doom. Then I moved from all things Doom to all things Quake. In between, I also found games like Descent and The Daedalus Encounter to also consume large amounts of my time.
I was never much good at any of them, but they were still fun to play. To this day, while I'm definitely NOT a gamer, I find them all still fun to play. Especially the Wolfenstein games, which fit nicely with my intense interest in all things related to World War II. Even while writing this article, it was hard to pull myself away from playing Wolfenstein 3D.
Wait. Did I say "playing Wolfenstein 3D?" Yep. I sure did.
On October 13, 2019, the Internet Archive released 2,500 more old MS-DOS games online, bringing the total number of MS-DOS games to just shy of 7,000. More may come at a later date, as they figure out ways to circumvent hardware dependencies and other limitations. All of the games are playable online in an online DOSBox window, in your browser. The games, for the most part, played exceptionally well in my installation of Firefox, on the PCLinuxOS Xfce community release.
So what can you expect to find there?
All of the Wolfenstein stuff is there, including the sequels Spear of Destiny, Spear Resurrection, and Spear End of Destiny. There is a lot of Doom stuff there, including the original, Doom II, The Ultimate Doom, and Final Doom. Another id Software game there is Heretic.
If you want to awaken the inner pilot in you, Microsoft Flight Simulator is also available. I remember trying it -- back in the day -- and I sucked at it worse than I did the run-n-gun games like Wolfenstein or Doom. Even though it's "Microsoft," this program was (and still is) a real gem. Many people have claimed over the years that this is as close as you can get to flying an actual plane without being in a plane.
Meanwhile, Interplay's Descent is available, along with its sequel, Descent II Vertigo Series. Or, maybe Donkey Kong is more of what you are looking for. Or maybe Pac-Man, or Ms. Pac-Man is more to your liking. One of my favorite arcade type games was Tempest. Another was Dig Dug. There is a PC/MS-DOS version of that game, called Digger.
Of course, who could forget the Leisure Suit Larry games, which are all also available. You can also find the original Tomb Raider. And who could ever forget the legendary Duke Nukem. There literally is something there for everyone.
Meanwhile, some of your favorites might have not yet been added. For example, I couldn't find any of the Quake games. I also couldn't find The Daedalus Encounter.
From the Internet Archive Blog, by Jason Scott:
The update of these MS-DOS games comes from a project called eXoDOS, which has expanded over the years in the realm of collecting DOS games for easy playability on modern systems to tracking down and capturing, as best as can be done, the full context of DOS games -- from the earliest simple games in the first couple years of the IBM PC to recently created independent productions that still work in the MS-DOS environment.
What makes the collection more than just a pile of old, now-playable games, is how it has to take head-on the problems of software preservation and history. Having an old executable and a scanned copy of the manual represents only the first few steps. DOS has remained consistent in some ways over the last (nearly) 40 years, but a lot has changed under the hood and programs were sometimes only written to work on very specific hardware and a very specific setup. They were released, sold some amount of copies, and then disappeared off the shelves, if not everyone's memories.
It is all these extra steps, under the hood, of acquisition and configuration, that represents the hardest work by the eXoDOS project, and I recognize that long-time and Herculean effort. As a result, the eXoDOS project has over 7,000 titles they've made work dependably and consistently.
So, if you're just wanting to take a trip down memory lane, or if you just have some time to fill, head on over and play a game or two ... or more.
Casual Python, Part 10
PCLinuxOS Family Member Spotlight: rolgiati
As told to YouCanToo
What is your name/username?
rolgiati (aka Ron the Frog)
How old are you?
71 last January
Are you married, single?
Married for 24 years to a British lady I met when she worked in France. Now a widower, working towards a new relationship.
How about Kids, Grandkids (names and ages)?
Boy and girl, Thomas (29) and Elizabeth (24).
Do you have pets, what is your favorite?
2 surly cats, one 45kg/99lbs. exuberant yellow lab, one timid cocker spaniel. Scotty (as in "I don't want to be beamed up Scotty") the lab is my favourite.
Are you retired, still working and if working, what do you do?
Retired early, after some time in the French military, then 15 years doing R&D, and computer programming, in a big insurance company in Paris. Spent years there writing Cobol and Iverson's APL on the mainframe, and even QuickBasic on Canon portables and Dbase3 on a PC; quite varied. Then, quit to adopt two kids, then moved to Darkest Paraguay.
Where do you call home? What is it like? IE: weather, scenery
Been living for the last 21 years in Asunción, Paraguay. It is a beautiful country. The weather is tropical, which means we don't have Summer and Winter, but North Wind and South Wind, which can bring hot or cold weather at any time of the year. The scenery is gorgeous. Gardening here is not a matter of helping plants to grow, but of swinging mightily with a machete to keep the green stuff from smothering you.
Forget all you may have heard about life in a South American country/dictatorship. I have lived here through three coups d'état, and they were much less bother than the students riots in 1968 Paris. Life always was quiet for foreigners, as long as one kept away from the local political life. We now have democracy, together with some street muggings and burglaries, which is why one keeps a 9mm or a .38" at hand just in case (although I never had reason to use it in 21 years).
Where did you go to school and what is your education level?
Last schooling was the French Army "Saint Cyr Ecole Spéciale Militaire" (our answer to West Point or Sandhurst) and Maths/Physics/IT at the university in Rennes.
What kind of things you like doing? hobbies, travel, fishing, camping?,br> Old cars and motorcycles, steam engines, track work on the Talyllyn Railway in Wales, model engineering; in my sinful youth, jumping out of airplanes with a parachute from a cliff-top with a hang-glider, scuba diving, pot-holing, dinghy sailing, piloting light aircraft, skiing, motorcycle riding, playing the Great Highland Bagpipes, Scottish Country dancing (where I met my late wife).
And reading, voraciously. I must have over 8000 books in the house, 95% of which I have read.
Why and when did you start using Linux?
When: In the days when Slackware became available on the Walnut Creek CDROM (and not a stack of 20-odd 3.5" floppies). It must have been 1993 or 1994, when one had to buy Mosaic to surf the web, because there were no free browsers then
Why: In four words "Blue Screen Of Death". Got fed up with the inadequacy of MS Windows, read about Linux, got the Slackware CD and was hooked. Later, I moved to Mandrake/Mandriva/Mageia, flirted with Debian (then Devuan when the Poettering Plague started spreading), and finally PCLOS where I rejoiced in finding again all the Drak/Drax tools I had been sorely missing in Debian/Devuan.
What specific equipment do currently use with PCLinuxOS?
A desktop box with a quad-core AMD processor at 2.7 MHz, 8Gb RAM, two 500Gb and two 2Tb hard disks in RAID1 arrays. Plus the usual keyboard, mouse, sound, printer, scanner, camera, etc.
Running PCLinuxOS, and Windows 7 under VMWare VirtualBox for a few progs I sometimes need, that won't run under Wine. Several other computers in the house (each has his/her own), both Linux and MS Windows, on a wired LAN (Coax, now Cat5) behind a dedicated box running the IPCop firewall.
Do you feel that your use of Linux influences the reactions you receive from your computer peers or family? If so, how?,br> It does, in that they consider me to be some kind of an IT guru, and often come to me with HW or SW problems which I try to help them with because, after all, a guru has a reputation to maintain. And I always threaten to sprinkle their MS Windows machines with Holy Water.
It helps that I started early in IT, on a vacuum tubes and 4kb ferrite torus memory IBM machine, input-output on punched card, no screen or keyboard of course but a big round manometre in the middle of the console, and a sign reminding the user to crash-stop the machine if the pressure (or the cooling water) dropped below 6 kg/cm^2.
Those were the days when first year IT students were taught how to design AND, OR, NAND and NOR gates with a few transistors and resistors.
My first personal computer was a Sinclair Spectrum+ in 1984, to which I added an Opus twin 3.5" floppy unit, later an Amstrad 1512 PC, from which I still have in my desk drawer the Intel 8088 processor which I replaced with an Nec V30 (30% speed gain) and later added 16 RAM memory chips to raise the memory from 512 to 640 kb, not to mention an arithmetic co-processor.
What would you like to see happen within PCLinuxOS that would make it a better place. What are your feelings?
Not something I wish for, but something I hope I'll never see: PCLinuxOS infected with the Systemd pox.
PCLinuxOS Family Member Spotlight is an exclusive, monthly column by YouCanToo, featuring PCLinuxOS forum member. This column will allow "the rest of us" to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.
If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to youcantoo, parnote or Meemaw in the PCLinuxOS forum expressing your interest.
De-Googling Yourself, Part 6
by Alessandro Ebersol (Agent Smith)
Last month, we paused this series of articles to address Richard Stallman's departure from the FSF presidency. Now let's get back to our subject, which is to introduce alternative services to Google's.
This month, we'll focus on YouTube, and what alternatives there are to this service.
YouTube, the once good video service...
Well, as I've criticized YouTube before, I won't write much about it here. Let's just punctuate the reasons that make it so bad. And, I repeat: It was good one day, but not anymore.
So, after this brief introduction, let's check out what options exist for YouTube.
Vimeo is the best way to put your highest quality videos online, with great tools for sharing publicly or privately.
Plus, Vimeo's iPhone app lets you upload, edit, manage and watch your videos right from your iPhone.
Pros
Excellent video player. Good mobile apps. No ads. Great community. Creators can sell or rent their content via Vimeo On Demand.
Cons
Crowded web portal. More expensive storage price tiers. Some mobile upload limitations.
Vimeo is best suited for people who prioritize high quality content over trends. Short films, animation, informative pieces and in-depth journalism are all at home on Vimeo. The consistent quality of Vimeo's offerings is a breath of fresh air after navigating the sea of YouTube hit or miss content, although you're unlikely to find the latest viral videos on Vimeo. In short, Vimeo is similar to a private art gallery compared to the public YouTube experience. Of course, the former is more expensive and less frequented, but their jobs are usually of a higher quality.
Federated video streaming platform (ActivityPub) using P2P (BitTorrent) directly in web browser with WebTorrent and Angular.
PeerTube was in alpha and became beta in March, 2019. It is free, decentralized, shared, and instance-based software. In fact, everyone can create their own instance and share their content with content from other instances. This gives you complete freedom of speech, neutral service, much greater content diversity, and even the ability to pay videographers based on fairer and different models. But above all, offer a free alternative to GAFAMs (Google, Apple, Facebook, Amazon & Microsoft) and their model.
BitChute is a peer-to-peer video sharing platform. Its mission is to put people and freedom of speech first. It's free to participate, create and upload your own videos to share with others.
BitChute has a phenomenal community and incredible potential, but it currently has some serious disadvantages.
BitChute aims to become an uncensored protected YouTube, in part, including decentralized bit-torrent functionality. The BitChute site as a single Internet site will remain centralized until everyone can somehow be co-host, such as FreeNet or ZeroNet. This is a "decentralization" myth/failure/supervision shared with numerous other sites that claim to be free, such as Steemit, Gab, InfoGalactic, etc. Unfortunately, torrent magnets are not in all videos and unfortunately, from time to time, your video torrent remains un propagated or downloaded. This could easily be corrected if, in addition to YouTube-style playback, BitChute also propagates all your videos. When torrents are missing or seedless, you are forced to watch the videos on their website and/or use a flash browser downloader to save your file. In addition, naming options settings for video torrent magnets are absolutely necessary. Currently, you download a video file with a short video ID alphanumeric encoded name instead of a good title, including useful descriptors such as its source (BitChute), author/channel/publisher, filename/video/title, date, and other details such as short alphanumeric code, video resolution, audio compression, and/or duration.
If BitChute really wanted to be successful, in addition to fixing the torrent issues mentioned, they would open the source project, have a forum and/or wiki for developers and users, encourage mirrored host sites, incorporate a cryptographic currency and/or reward system (which is already underway), social networking integrations and I'm sure of countless other things that other people will want, or offer.
Tired of all the YouTube issues? Are you tired of robots reviewing your videos for offensive content instead of real people? Do you miss YouTube's old feel with personalization, a community, and a platform you could grow on? Well, if you answered yes to any of these questions, you'll love VidLii. VidLii provides a platform for users to upload videos freely, with guidelines that keep the environment user-friendly without preventing you from having a free voice. You can upload anything from social comments to satire. Explore the community, upload videos and show yourself. Join VidLii today if you just want a sense of nostalgia or want to be part of this amazing site as you grow. From a site user, not a team member, I can say that this site is amazing and has great potential to be known as the next YouTube.
Compared to YouTube, this is the best way. Google has removed features from YouTube for some time. VidLii is bringing back these features (such as annotations (coming soon!), Community Guide, video responses (we hope a few days after this review), channel 1.0, channel 2.0, channel banners (for partners only in August), star rating & Plus mobile channel newsletters & widgets
Dailymotion is a video sharing service site based in the 18th arrondissement, Paris, France, and is the world's largest video site after YouTube.
Dailymotion organizes web videos and displays them in a steady stream for viewing and enjoyment of sharing. You will appreciate its ease of use.
Pros
Limit the videos: Dailymotion organizes videos by genre, so you can filter videos quickly.
Follow your favorite: If you have a favorite video source, such as Buzzfeed can follow them after that, the source appears in the Next menu for easy access.
View your history: If you forgot to tag or add a specific video to a playlist, the History feature is useful for going back and browsing all previously viewed videos. You can also remove specific videos from history.
Cons
Login required: Dailymotion lets you watch all the videos you want without having to create an account or log in with your Facebook credentials. However, if you want to create a playlist or add a video to your favorites, you need to create an account first.
Verdict
Dailymotion is a well-designed application to keep you up to date on the latest and greatest videos on the web. Recommended.
D.Tube is the first decentralized encrypted video platform built on the STEEM Blockchain and peer-to-peer IPFS network.
The interface is identical to the current YouTube.
Pros and Cons
Pros:
In DTube, there are no hidden algorithms that control the visibility or monetization of certain videos over others. All DTube data is public and can be reviewed by anyone with an internet connection.
Due to the decentralized nature of IPFS and the STEEM blockchain, DTube cannot censor videos or enforce guidelines. Only users can censor it, through the power of their positive and negative votes.
Cons:
Vlare.tv is a video sharing site created by Jan and Suduerion in an attempt to provide creators with an alternative to YouTube.
The site combines elements of modern YouTube and social media as it aims to increase interactions between creators and the people who follow their channels.
According to Plutonium Digital, Vlare would originally be a new build of VidLii. (as creator Jan also created ClipBits, VidBits and VidLii). But over time, it would evolve into a new site that aimed to be closer to the current YouTube.
When it was first announced, people interested in participating would need to sign up for VidLii, as well as request access to Alpha (via a direct, private message).
The site was launched on December 10, 2018 and has been in testing since September, 2018. The site would include non-YouTube features, including: Groups, Talking to Friends, Watching Videos Together, and Creating Blog Posts.
On April 24, 2019, Vlare's Twitter account announced that Vanillo Sudeurion's co-founder had joined Plutonium as a content creator and site developer, where he was assigned to design the site's user interface and improve the site to as it approached its public release.
In a screenshot of Discord, Jan said he will try to get Vlare to annotate its videos, a feature that YouTube removed in January 2017.
On May 7, 2019. Vlare came out of beta and was released to the general public.
LiveLeak is a London-based video sharing site. The site was founded on October 31, 2006, in part by the team responsible for the shocking website Ogrish.com, which was closed the same day.
LiveLeak aims to capture images of reality, politics, war and other world events and combine them with the power of citizen journalism. Hayden Hewitt of Manchester is the only public member of the LiveLeak founding team.
"YourSay" is a section of the site where users upload their own videos, like a vlog. Unlike YouTube, LiveLeak vlogs are more political and are known for debate.
LiveLeak currently has several categories, including Syria and Ukraine, where graphic content for various conflicts can be viewed.
Metacafe is a video sharing site specializing in short form video entertainment in the categories of movies, video games, sports, music and TV.
The company was headquartered in San Francisco, California, with an office in Los Angeles. Metacafe was acquired by Collective Digital Services in 2012 and at that time it ceased to exist as an independent company.
In its early years, Metacafe was similar to other video viewing sites such as YouTube or Dailymotion, but has since become a short-form video entertainment. The company's partners included content providers such as major movie studios, video game publishers, cable and broadcast networks, record labels and sports leagues.
The site is supported by advertising, working closely with brands in the entertainment, electronics, telecommunications, consumer packaged goods, food and beverage and automotive industries.
Metacafe used to attract more than 13 million unique monthly viewers in the US and broadcasts over 53 million videos in the US each month, according to comScore Video Metrix (March 2011). The overall audience of the site was over 40 million unique monthly viewers.
Last, but not least, there's Full30.
YouTube's recent restrictions on firearm content, which include bans on videos that link to the sale of guns and videos that teach viewers how to install attachments like high-capacity magazines, have already had dramatic effects on the online video community's hunters, sport shooters, and weapons enthusiasts. As those creators try to figure out if they will be able to have a future on the world's top video site, several other niche players are looking to fill the void. Full30, a site specifically dedicated to firearm content, has announced an expansion, while the Utah Gun Exchange, a retail platform, has positioned itself to enter the video industry as well.
The domain was registered in 2014, and, in 2015 it was launched to the public. The company behind Full30 invited content creators to join the site and reserve their channels, since they felt Youtube censorship would entice a mass exodus from the popular video site.
One of its most prominent users is Hickok45, who began sharing his videos there after running into trouble with YouTube back in 2016. As of this post, Hickok45 has about 30,000 subscribers on Full30. On YouTube, he has nearly 4.5 million subscribers and over 1,800 videos.
Regarding censorship, a spokesperson for Full30 stated: Full30.com does not censor its content creators in any way. Full30.com does not remove videos or add videos for its content creators, only the content creators can add or remove their videos.
I took a look at the video site (they have many sections: blog, articles, an online shop) and it is very complete and filled with information for gun enthusiasts. But, you won't find other genres there, since it is a site specialized in firearms (I was hoping to find some FPS games... Who knows? Deals with guns too, not real, but...)
Summary
Of these services, Vlare stands out, which, having been launched in 2019, is already starting to make a considerable legion of fans, with social aspects, respect for the creators and a more accessible platform than YouTube.
Stay with us for the next chapters in this series, where I'll write about Android and finally how to effectively circumvent Google's spying services.
Mind Your Step, Part 3
by phorneker
Another holiday season is right around the corner. We all know what that means ... another season of shopping for holiday gifts ... and another season for cybercriminals to cash in due to the number of brick and mortar retailers disappearing this year.
On September 30th, Forever 21 filed bankruptcy and subsequently, all of its stores closed down. GameStop is predicted to be the next retailer to go. GameStop started out as Electronics Boutique back in the 1990s, which was itself spun off from Waldenbooks, of which it, competitor Borders and Builder's Square were purchased by K-Mart Corporation (pre-Sears)...and we all know what happened there. GameStop was spared its demise since it was spun off from Waldenbooks. I remember Electronics Boutique well, because not only did it sell video games and gaming consoles, but it also sold PC software. It is there where I purchased copies of Lotus Improv, Turbo Pascal for Windows and Turbo C++ for Windows. (I was running OS/2 at that time.) GameStop is still a functioning retailer, but for how long? Last time I was in a GameStop, they sold the major consoles and all the popular games. For a while, they were selling second hand iPhones and Android powered smartphones. Other than that, there is a 50/50 mix of new and used gaming hardware and software, including some PC-based titles that could run on Wine. At times, I would find a MS-DOS based title now and then, but even that is becoming a rarity. (A better source for MS-DOS titles would be a thrift store such as Goodwill.) What could ultimately kill GameStop would be the next generation of gaming consoles, which would require a high speed internet connection to function as all games would be online games (i.e. no CD/DVD/Blu-Ray discs needed). The currently available Sony PlayStation 4 largely depends on the Internet to function. |
HTML trick that phishes for Stripe users
Bleeping Computer reported on a phishing e-mail containing a link to lure Stripe users to a fake website.
The way this link works is in how the HTML tag was written.
<a class="mcnButton"
title="Review your details"
href="http://example.com/phishing page">Review your details
I split this HTML tag to show you what is happening here. The title parameter tells the browser to display this text instead of the URL indicated in href.
In this example, the URL is a sample created by the staff at Bleeping Computer.
To find out the exact URL within the link, right click on the link and select "Copy Link Address", then open a text editor (anything will do here), and paste (usually with Control-V) the URL into the editor.
(You could paste the link to the address bar in the browser, but using a text editor is much safer.)
Where it all started for me 26 years ago!
This is a top view of the building where my information technology career began. This building and the one just to the north were constructed in 1975 at the southwest corner of Vale Park Road and Valley Drive in Valparaiso, Indiana. This building is called 600 Vale Park Plaza South and was used as a place for credit reporting and for debt collections until December 1998. (I started work here in 1993.) In 1998, Equifax made a decision to allow consumers to obtain credit reports online rather than obtain reports through the local credit bureaus. This would prove to be a big mistake as we have seen in the infamous 2017 data breach.
As a result, the building became vacant until 2001, when the building was renovated after being sold to Purdue North Central for its Porter County campus. The building was then used as an educational facility until the merger of Purdue North Central and Purdue Calumet campuses to form what is now Purdue Northwest (https://www.pnw.edu), hence eliminating the need for the building.
This past October, Bradley Company of Merrillville, Indiana purchased the two buildings to be renovated (again) for use as a medical facility (reported to be the future Valparaiso office of Michiana Hematology).
Source: https://ci.valparaiso.in.us/AgendaCenter/ViewFile/Agenda/_01292019-291
The other building, 600 Vale Park Road North was home to a mental health outpatient clinic in the 1980s, and more recently, an office for General Insurance Services (agent of Traveler's Insurance which has since moved to a downtown location), and a truck driving school for C R England (https://www.crengland.com).
To this day, SuperPages.com still has Credit Bureau Services, Inc. listed at 600 Vale Park Road, twenty years after the business closed down!
Source:
https://www.superpages.com/bp/valparaiso-in/credit-bureau-services-inc-L2709777483.htm
Search Engines do not always get it right.
These days, I use DuckDuckGo as my go-to site for web searching.
When searching for phone numbers this way, the results you get are quite unpredictable. Even with Google, if a phone number is known to be legitimate, the results will show you who that number belongs to if that number is a published number and easily available.
The website 800notes.com is the first website to track unsolicited phone numbers. Typically, the results would include websites such as okcaller.com, callername.com, and mylife.com, the latter of which is a repository that reports reputation scores ranging from 0.0 to 5.0 with anything above 4.0 being a good score.
The paid version of MyLife allows you to control what others see on your reputation report, which actually matters more than the contents of your credit report. Reputation scores lower if you have public records on file regarding legal issues such as bankruptcies, lawsuits, judgments, and the like normally housed in county, state and federal facilities.
MyLife also allows you to have sensitive information removed from websites that have that information for sale. (I have successfully had such information removed from 16 repositories this way!)
Websites such as ZoomInfo get their information primarily from LinkedIn. Unfortunately, the website more often than not gets it wrong when it comes to the resulting profiles.
And then, there are fake databases such as Hodges Directory and USPhoneBook whose sole purpose is to mislead skip tracers by providing bogus information in the search results.
For those of you who do not know, skip tracing is a technique used by private investigators, debt collectors, or anyone looking for the whereabouts of missing people to gather as much information on the subject as possible. This includes subscribing to paid services such as BeenVerified, Intelius, MyLife, and searching social media outlets such as Facebook and Twitter (whenever the Donald is not using it), as well as the standard DuckDuckGo, Google, and Bing searches. The term skip here is derived from "skipping town", or someone who disappears and needs to be found, especially when collecting debts owed to creditors. Skip tracing is used by collection agencies whenever a debtor has given misleading, omitted, or false information to the creditor or the collection agency. Successful collections depend upon accurate information contained in files within the agency's database(s). Usually this process is done during the initial period and according to procedures allowed by the Fair Debt Collection Practices Act. |
You will be surprised....
...at what you will find when you search for yourself online. There are reasons why you would want to do this.
When searching for yourself, here are some tips I have used:
On the subject of uncommon last names, the "c" in "hornecker" was dropped in the early 1900s by one branch of that family at the time of immigration to the US. As a result, there are only 78 people (including myself) with that last name (spelled without the "c") in the world the last time I performed that search. When an image search was performed on my last name, there is a world of difference between DuckDuckGo and Google when it comes to the images revealed in the search. |
Usually only the first three pages of the results matter when it comes to the search results. Why?
Because most people who perform these searches do not have the time or patience to wade through hundreds of irrelevant results just to get the results that matter.
Another reason I use DuckDuckGo is that there are no ads contained in the first page of the search results. Advertisers pay Google to include their websites at the top of the list. Thankfully, these results are marked as advertisements, but you have to scroll down the page to get to the first actual result.
Before you shop online...
It is a good idea to change the passwords on all your accounts where you shop online before you do any online shopping this season. (Especially if you have an Amazon or a Wal-Mart.com account). This past month yielded a massive data breach that compromised more than 1000 online retailers in one fell swoop.
Also, keep track of where you shop online so you know what packages you expect to receive and from whom.
Last year, the USPS left a notice of an undeliverable package with a tracking number, but no return address. This was a package I did not expect to receive, and was sent directly from the Valparaiso, IN post office.
I simply ignored the notice and allowed the package to be sent back, and that was probably a good thing.
Mail without a return address is handled as a "dead letter". The USPS attempts to find the sender of the "dead letter" (or package), which means that a postal inspector can legally open the package or letter to find out who the sender was and what was intended to be sent.
Also, if there is no return address, this alone should be a red flag and the package should be handled as a suspicious package, which should be refused. This also means that your mailing address has been compromised in some way. Thankfully, the fact that this package got returned means the mailing address could not be verified (and that is a good thing).
The bottom line here is this:
Keep track of everything you purchase online and make sure that you receive the expected package(s) and only the expected package(s).
Reputable vendors will have a method of checking on your purchases, either through legitimate tracking numbers, or through a customer service number to call or website to visit.
Remember, though you are purchasing through secure websites, do not assume that you are not being tracked by someone else. Evidence of this will appear in phishing e-mails. Be sure that when you visit the retailer, manually type in the URL of the retailer and do not rely on (or even trust) links in messages received.
Of course, if you have Amazon or other retailers bookmarked in your web browser, you can use those as well, as they have the correct URL spelling.
It is also a good idea to shop through a configured VPN as well.
PCLinuxOS Bonus Recipe Corner: Impossibly Easy Vegetable Pie
Impossibly Easy Vegetable Pie
Ingredients:
2 cups chopped broccoli or sliced fresh cauliflowerets
1/3 cup chopped onion
1/3 cup chopped green bell pepper
1 cup shredded Cheddar cheese (4 ounces)
1/2 cup Original Bisquick™ mix ** See our homemade Bisquick recipe mix
1 cup milk
1/2 teaspoon salt
1/4 teaspoon pepper
2 eggs
Directions:
1. Heat oven to 400F. Grease 9-inch pie plate. Heat 1 inch salted water to boil in medium saucepan. Add broccoli; cover and heat to boiling. Cook about 5 minutes or until almost tender; drain thoroughly. Stir together cooked broccoli, onion, bell pepper and cheese in pie plate.
2. Stir remaining ingredients until blended. Pour into pie plate.
3. Bake 35 to 45 minutes or until golden brown and a knife inserted in the center comes out clean. Cool 5 minutes.
Expert Tips:
Grab a 10-ounce package of chopped broccoli or cauliflower from the freezer. Use it instead of the fresh broccoli or cauliflower; it doesn't need to be boiled. Just thaw, drain and add it to the pie.
For an Impossibly Easy Spinach Pie, use 1 package (10 ounces) frozen chopped spinach, thawed and squeezed to drain, for the broccoli; do not cook. Omit bell pepper. Substitute Swiss cheese for the Cheddar cheese. Add 1/4 teaspoon ground nutmeg with the pepper. Bake about 30 minutes.
Savory Impossibly Easy Pies can be covered and refrigerated up to 24 hours before baking. You may need to bake a bit longer than the recipe directs since you'll be starting with a cold pie. Watch carefully for doneness.
** Recipe for our homemade Bisquick Mix.
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